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Beginnings are usually scary 
and endings are usually sad, 

but it's everything in between 
that makes it all worth living.  

-Unknown 

Michael Koren, Purple Haze 
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 SSCC Officers and Chairs 2012-2013 
President:        Angelique Raptakis 
Vice President:     Ron Freudenheim 
Treasurer:      Jerry Fath   
Secretary:      Ted Ringger  
Directors:      Carl Brandt 
      Mike Lux 
      Michael Koren 
Cable Release Editor: Dave Mullen    
Competition Chair:  Bob Peters 
                     Jim Rogers   
Program Chair:    Coco Simon  
Third Thursdays:     Michael Koren  
Membership Chair:  Vacant 
Field Trip Chair:    Bob Catlett   
Historian:      Norm Bernache 
PSA Rep:      Dave Powell 
Website Manager:    Dan Sisken 
Exhibits Chair:    Jim Auerbach 
     
E-mail addresses for some officers are in the Member 
Handbook, others are available on request.  Please contact  
Dave Mullen at dave@nora-school.org. 
 
Visitors and prospective members are welcome.   
Membership is open to all persons interested in  
photography.  For more information, contact Dave Mullen 
at dave@nora-school.org. 
 
The Cable Release is published ten times each year,  
September through May plus Summer, for members of the 
Silver Spring Camera Club.  All rights are reserved, but 
excerpts may be reprinted without permission provided 
proper credit and prior notification is given.  Articles are 
written by members of SSCC, which is a nonprofit  
organization dedicated to the advancement and   
enjoyment of photography. 
 
SSCC member submissions for the Cable Release should be  
directed to Editor, Cable Release, at  dave@nora-school.org 
More information is available at the SSCC Website:  
www.ssccphotography.org  
 
The Silver Spring Camera Club has been a member Club of 
the PSA since the club was founded in 1950.  For  infor-
mation regarding the benefits of a PSA individual member-
ship and for PSA  sponsored activities, please contact our 

Club PSA  Representative. 
 
© 2013 Silver Spring Camera 
Club and its contributors. All 
contents of the Cable Release are 
copyright protected. No material 
herein may be reproduced in any 
manner without the written 
permission of the Editor, Author, 
or Photographer. 

Issue Highlights 

    3   This Month at SSCC  
    4   Field Trip Information 
         5   Kernel’s of Koren  
    8   Competition Results  
  12   Field Trip Photos 
  20   Mirrorless In Manhattan 

SSCC Meeting Location 

All three major monthly meetings of the Club Year are held at 
the Marvin Memorial United Methodist Church at Four Corners 
in Silver Spring.   

Directions: 
From downtown Silver Spring:  Go north on Colesville Road 

(Rte. 29); take a right onto University Blvd. East; then left into 
the church parking lot A. 

 
From College Park/Takoma Park:  Take University Blvd. 

West.  As you approach Rte. 29, move to the far left lane and 
turn left into church parking lot B.  Or pass through Rte. 29 
intersection and turn left at the loop just past McDonalds.     
Proceed on University Blvd. East, pass through Rte. 29          
intersection, and quickly get in the far left lane and enter into 
church parking lot A. 

 
From points north of Four Corners:  Proceed south on Rte. 29 

and turn right onto University Blvd. West, move into the far left 
lane and turn left at the loop just past the McDonalds.  Proceed 
through the Rte. 29 intersection, and turn left into church   
parking lot A. 

 
From Wheaton and points west of Four Corners: Go east on 

University Blvd.  Pass through Route 29 intersection and turn 
left into parking lot A. 

Wherever you park, walk to the southeast corner of the 
Church and enter Room 204.   

 
All SSCC Meetings begin at 7:30 pm. 
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February 7 
Speaker Night: Michael Borek 

 
Many of us have visited the Eastern State Penitentiary 
and discovered the fascination of an abandoned build-

ing. Our 
speaker this 
month, Mi-
chael Borek, 
has been simi-
larly attracted 
to an old lace 
factory in 
Scranton, PA. 
He has docu-
mented it ex-

tensively in images that are poetically realistic as well 
as strangely surrealistic. 
 
A photographer of Czech origin now based in Bethes-
da, Michael grew up under communism in what he 
describes as “newly created, cheerless urban land-
scapes.” He found these constructions depressing and 
was instead drawn to older buildings. That these old 
structures were dilapidated and deteriorating only add-
ed to their appeal. He continued to be fascinated by 
the visual archeology of urban decay after he moved to 
the US in 1992.  
 
In 2006, Michael became a member of the Multiple 
Exposures Gallery in the Torpedo Factory in Alexan-
dria and started showing his photographs. Four years 
ago, he had a solo show at the Czech Embassy in 
Washington, DC, and two years ago, he was a featured 
artist in the Rayko Gallery in San Francisco. Last year, 
his photographs from the old lace factory in Scranton 
were selected for juried shows by curators from the 
Corcoran, Whitney, Hirshhorn, and Getty museums, 
and one of them won second prize in the fine art cate-
gory of the international competition of FotoWeek 
DC. In April 2013, he will have a retrospective exhibi-
tion at the American Center in Prague, Czech Repub-
lic. 
 
Michael exhibits extensively, and his work has been 
shown in well known venues in New York, Richmond, 
San Diego, Philadelphia, and elsewhere. He has also 
won numerous awards in addition to those mentioned 
above. 
 

February 14 
Competition Night: Topic-Abstracts 

Judge: Roy Sewall 
 
For the February competition – 
abstracts – our judge Roy Sewall 
has deep experience with our 
topic. He also has a close affilia-
tion with Joe Miller, the godfa-
ther of abstract photography in 
our region (and far beyond). His 
photographic biography, howev-
er, covers a much broader range 
of subjects and reveals a passion 
for the Potomac River and the 
C&O Canal. 
 
In 2007, Roy became the first Chair of the Board of 
Directors for the C&O Canal Trust, a non-profit 
friends group for the National Park Service.  Roy 
joined the Board of Directors of Potomac Riverkeeper, 
Inc., where he will continue his commitment to the 
well-being of our Potomac River. 
 
Roy’s second book, Great Falls and Mather Gorge, was 
published in 2009, which cemented his reputation as 
one of the leading photographers of the Potomac River 
and C&O Canal. In addition, he was a guest on WE-
TA’s TV program Great Views of Washington D.C.; the 
lead photographer in the Best of D.C. 2009 publica-
tion; in feature articles in the 2009/2010 Where 
Guestbook/Washington, D.C. and 2012/2013 Where 
Guestbook/Virginia; the lead still photographer in The 
Nature Conservancy’s 2011 video The Potomac Gorge; 
featured guest on “Career Choices” on Montgomery 
County Cable Channel 21 in 2012; and guest on the 
upcoming video documentary Potomac Voice, sched-
uled to be released this year. 
 
After completing Great Falls and Mather Gorge, Roy 
turned to the creation of large fine art prints. He has 
developed diverse bodies of work for exhibitions that 
include water-centric landscapes, unusual foreign ar-
chitectural sites, Washington DC scenes, historical re-
enactment, abstracts, and mysterious scenes of people 
in the woods. He has won major awards at the Epson 
International Panoramic and Joe Miller Abstract com-
petitions, exhibited at 10 community art spaces, and 
judged over 40 camera club competitions in the re-
gion. 

This Month at SSCC 
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Inclement Weather Policy 
If Montgomery County schools close,   

SSCC is closed. 
For up-to-the-minute information  

go to www.montgomeryschoolsmd.org 

Help Needed 
 
Halfway through the year, with 85 members, SSCC is 
still looking to fill several positions! It’s time to step 
up and volunteer! 
 
Your club needs a Membership Chair, which requires a 
friendly member who regularly attends meetings to fill. 
The job involves being the point of contact for inquiries 
from the website, greeting new visitors, and following up  
by sending a Cable Release to them.  
 
Your club also needs a backup and trainees for a couple 
of other positions, including Competition Night projec-
tionist and Cable Release Editor.  Jim Rogers would 
love to teach another member how to manage the soft-
ware and hardware so that he can go out of town occa-
sionally, and Dave Mullen would like to show someone 
how the Cable Release sausage is made.  If you are inter-
ested in any of the these three positions please send an 
email to dave@nora-school.org.  

Douglas Wolters, Leafscape #14 

February 16 
Field Trip: Baltimore Botanical Gardens 

Bob Catlett                                   
 

Heading back north to Baltimore, the SSCC caravan 
will visit the Baltimore Botanical Gardens in Druid Hill 
Park to shoot the flora and fauna in the greenhouse and 
gardens. The carpool will leave the Giant supermarket 
parking lot at 9:30am, and with any luck we can talk 
Bob into returning to Café Hon for lunch. Directions to 
the Giant parking lot are on the website and in the 
Member Handbook, which can be found n the Downloads 
section of ssccphotography.org.   

 

February 21 
Education Night: Macro/Close-Up Photography 

Michael Koren 
 
This evening we will prepare for the April competition 
and learn about the tools and techniques for shooting 
Macro and Close-up images.  As a bonus, we’ll even ex-
plain the difference between Macro and Close-up! 
 

March Education Night – Sneak Peak 
Wedding Photography 

Irene Abdou will return to the club to give a how to 
presentation about wedding photography. 

Elise Shurie, Trumpet Babies 
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Recently the Board received feedback from a 
former member that decided to not renew 
their membership.  In a nutshell, this person 
felt unwelcome and not part of the group.  
Certainly this is a problem on many levels; 
after all, we are a Club, the Silver Spring 
Camera Club.  The key word is Club, not our 
meeting location.   
 
So, what could we have done better?  This is 
a question the Board traded hundreds of 
emails about soon after receiving the feed-
back.  There were many good suggestions and interest-
ing insights from newer members to veterans of dec-
ades.  The topic will come up again at the Board meet-
ing at the end of February. 
 
As members of a club we have a responsibility to be 
friendly and social to other members and guests.  
Those that treat meetings like a movie, (arrive a few 
minutes before the start, keep quite and leave as soon 
as the credits start rolling), are not experiencing every-
thing the club has to offer.  Yes, in the beginning it’s 
awkward and uncomfortable to talk to strangers, but a 
simple thing like helping to put out chairs, set up the 
projector screen, or closing the curtains will undoubt-
edly start a conversation with someone else in the 
room. We are all responsible for our own happiness 
and growth, so take advantage of the four meetings 
each month, each different in scope.  Attend the 
monthly field trip to shoot pictures with other mem-

bers.  The learning opportunity along with 
the camaraderie of shooting with fellow 
photographers is very rewarding.  Come to 
a board meeting and contribute your 2-
cents to the conversation. You might have 
so much fun you’ll decide to join the board 
and serve to make the club better. 
 
The Board also has a responsibility to 
make decisions that benefit members of 
the club.  Recently we have decided to 
incorporate more social time at the begin-

ning of some meetings by starting a little earlier.   We 
now have a Google forum for members to ask ques-
tions.  Our website attracts many visitors to meetings 
but we still strive to make it better. The Cable Release 
has won best newsletter in the nation two years in a 
row, with all members invited to contribute articles 
and pictures.  We have a Flickr space to share pic-
tures.  Education night will now include a few minutes 
of Q&A before each meeting. And we continue to 
work on ideas that will make the member experience 
better and more fulfilling each new meeting. 
 
Feedback is good but avoiding this kind of feedback 
with proactive member interaction is great.  Please do 
not hesitate to contact a Board member if you have a 
concern or feel unwelcome. 
 
The Beatles said it best: “And in the end, the love you 
take is equal to the love you make." 

Kernel’s of Koren 
Michael Koren 

Bob Catlett, San Cristobal Bob Catlett, Pink Trumpet 
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Member News 

At the end of February, Doug Wolters and Coco Si-
mon will open the second of their three exhibits on 
the abstract play of winter solstice light in the Wash-
ington Cathedral. The first – and very successful – 
exhibit, in December 2012, was held at the Damascus 
United Methodist Church. The February-March show 
is being installed at Woods Memorial Presbyterian 
Church in Severna Park, MD. The third exhibit, April
-May, will be shown at nearby Christ Congregational 
Church in Silver Spring. 
 
Gene Luttenberg  has an exhibit opening this Sunday  
titled Seeds of Rebirth: The Thousand-year Lotuses of 
Kenilworth.  In theses lotus blooms Gene has found the 
inspiration for his own creative rebirth, the fruit of 
which can be seen at Zed's Café, 8225 Georgia Ave-
nue, Silver Spring, MD.  The opening reception is this 
Sunday, February 3, from 2-4pm.  
 
The Journeys exhibit, with works by members of the 
Silver Spring Camera Club, is now on display at the 
Tate Gallery in the Christ Congregational Church 
from February 2 - April 8, 2013.  The address is 9525 
Colesville Road, Silver Spring, MD 20901. There will 

be an Artists’ Reception on March 23 from 1-3pm. 
Exhibitors include Jim Auerbach, Carl D. Brandt, 
Alam Burhanan, Greg Holden, Stan Klem, Dave 
Mullen, MyPhuong Nguyen, Elise Shurie, Ha Tran, 
and Michael Tran 
 
Jim Auerbach is teaching Intermediate Digital Photog-
raphy from March 20-April 10. Details about the 
course are in the January Cable Release.  Jim spoke in 
January at the Baltimore Washington Photographers 
Art Association on Inside Vietnam and Cambodia: A 
Photographic Travelogue. He will make the same 
presentation to the Carroll County Camera Club on 
February 18.  His images can be seen in several cur-
rent and upcoming exhibitions including Journeys, not-
ed above, and: 
•Images from the Baltimore Washington Photographers 
and Art Association at the Maryland Senate Building in 
Annapolis, from January 17-April 15; 
•Woodland Muse, a multi-media exhibition at the 
Oakland Mills Meeting House Gallery, from March 14
-May 11. Artist Reception from 1:30-3:30pm on Sun-
day, March 17.  5885 Robert Oliver Place Columbia, 
MD 21045. 
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Watch Man 

Walking through the City 

In Memorium 
George DeBuchananne 

 
Longtime member George DeBuchananne 
passed away on January 26 after a long ill-
ness. His wife Vera expressed gratitude to his 
SSCC friends for their years of camaraderie 
and support.  On this page are some of 
George’s competition winners from the past 
few years. We have published 30 of George’s 
winning images in the past three years. 

Blasts of Color  

Circle to the Top 

Barn Door Hinge 
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Mark the BACK of the matte 
with photographer’s name and title 
of the image and an arrow indicat-
ing the print’s correct  
orientation 

Print Image Entry Guidelines 

Projected Image Entry Guidelines 
JPG File Format, 1024 pixels wide (MAX) by 768 pix-
els tall (MAX), sRGB color space, 500 KB max size, 
correct file name format. 
File Name:  Class~Maker's Name~Image Title.jpg 
Example:  Nov~Tom Jones~Good Friends.jpg 
The tilde ~ character separates 3 fields of the file 
name. 
Class – Nov or Adv 
Maker's Name – spaces allowed, use the same name 
throughout the year.  
Image Title – spaces allowed, no commas. 
Submissions by e-mail only to:  
 SSCCphotography@Yahoo.com 
Deadline:    Midnight  1-week before competition 

January Competition Results 
Topic: Open 

Judge: Mark L. Power  
 

Advanced Color Prints, 24 entries  
 1st Robert Catlett San Christobal 
 2nd Mark Ratner Antique Car 
 3rd Gene Luttenberg Cherry Hill Water Pump Station 
 HM Mark Ratner Butterfly on Ceiling 
 HM Chuck Bress Pigeon 21 
 
Advanced Mono Prints 
 1st Mike Lux  Close Encounters 
 2nd Michael Koren Lot's Wife by the Pool 
 3rd Gene Luttenberg The Sabbath Blessing 
 HM David Powell Louisville #1 
 HM Mark Ratner The Pyramid 
 
Advanced Projected Images 
  1st  S Antonelli    Floating In Space 
  2nd  Dave Powell   Azaleas 
  3rd  Koller     Empty Corner Shadows 
  HM Bob Catlett    Pink Trumpet 
  HM Douglas Wolters   Leafscape #14 
  HM  Michael Koren  Purple Haze 
 
Novice Color Prints  
 1st Patrick Stuart At the Crossroads 
 2nd Jim Turner  Easter Orchid 
 3rd Jim Turner  Cattleya Orchid 
 HM Douglas Wolters By the Stream 
 HM Kim Akkrach Fire Works 1 
 
Novice Mono Prints 
 1st Patrick Stuart Brocken Down 
 2nd Jim Turner  Klampenborg Station 
 
Novice Projected Images 
  1st Larry Burton    From Alcatraz 
  2nd Larry Burton    Sunrise Grand Canyon South Rim 
  3rd Karen Carkhuff   Last Samurai 
  HM Elise Shurie    Trumpet Babies 
  HM Kay Carkhuff   Gone with the Wind 
  HM Ron Freudenheim Ghost Flowers 
  
      Congratulations to all who entered! 

February Topic Definition: Abstract 
All topic definitions for the entire club year can be 
found on page 15 of the SSCC Member Handbook, 
available in the Downloads section of ssccphotog-
raphy.org. 
 
February Topic-Abstracts   
Abstract images are nonrepresentational.  Though they 
may contain identifiable subject matter, the principal em-
phasis is on pattern, form, tone, texture, color, etc.  Ab-
stracts may be “created” (e.g., light-painting with whorls of 
smoke) or “found” (e.g., close-up of coiled copper tubes).  
Any subject matter and any technique or combination of 
techniques are acceptable. 
 
Looking Ahead: March Topic-Open   
Any subject matter, theme, and technique is acceptable, as 
long as the principal emphasis is on photography and shows 
the personal interpretation of the photographer.  

For full details and tutorials on  
Competition please see the  

Member Handbook in the Downloads 
section of the website. 

Projected Entries 
Due February 7 

By Midnight! 
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From the President’s Desk 
Angelique Raptakis 

Welcome to our newest members: James Cooper, Eliz-
abeth Echols, Tam Le, Robin Majeski, Gregg Micklos, 
Donald Moore, Nicholas Pyle, and Andrew Rein. Please 
introduce yourselves to them at meetings and field 
trips.  
 
The next Board Meeting is scheduled for Thursday, 
February 28 at 7:30 pm, and is open to all members.  
According to the SSCC By-Laws, “members not on 
the board may speak before the board, but shall not 
have a vote in its business.”  If you are interested in 
attending, please let Angelique or Coco know and we 
will send you directions. 
 
 
 

Member's Reception, Thursday, March 7, at 7:00pm 
Our March 7 meeting will begin at 7:00 instead of 
7:30 with a short “social hour.” Take this opportunity 
to get know other members, to ask burning questions 
about competition rules, or to find out what lens that 
guy used in his winning image last month. Talk to Dan 
about getting involved in the on-line forum. Talk to 
Dave about doing an article for the Cable Release. Talk 
to Coco if you have a recommendation for a speaker 
or a judge. Find out how to participate in the Picture-
A-Day project. Come see Bob about plans for this 
year’s field trips. Ask Michael what’s coming up on 
education night. Give your suggestions to Angelique 
about potential club activities.  And do feel free to 
bring a friend who might be interested in joining 
SSCC! Refreshments will be served. 

Patrick Stuart, Castillo de San Cristobal 
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Plan Your Shooting! 
2012 —2013 

Competition Topics 
  

September — Open 
October — Nature 
November — Open 
December — Architecture 
January — Open 
February — Abstracts 
March — Open 
April — Macro / Close-ups 
May — Reflections 
June-Year End 
Definitions for all topics can be 

found in the Member 
Handbook 

For full details and tutorials on the Competition Rules and other club information  
please see the Member Handbook,  available for download on the Club website. 

Douglas Wolters 
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S Antonelli, Floating In Space 

Shrouded Dome, Douglas Wolters Patrick Stuart, Broken Down 
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Scenes from the January Field Trip to Hopkins vs. Haverford 
Photos by Bob Catlett, Mike Koren, Jim Rogers, and Mike Lux 
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Tones instead of Hues: the world in black-and-white 
Mark L. Power 

While driving home after having the honor of being a 
judge at the SSCC January competition, I began to 
wonder why, in general, the black-and-white photos 
seemed weaker than the color entries. There wasn't 
much difference in content but technically, in terms of 
craft, they seemed not as strong. This is probably more 
an impression than a fact, but it did cause me to won-
der, and I think it may be because many SSCC mem-
bers shoot first in color and then in post-processing, to 
borrow a cinematic phrase,  render the image as a 
monochrome. Photographers of the SSCC are not 
alone in this; it is a common practice in the world of 
digital photography, and I have done it a number of 
times myself. Nevertheless, I feel it makes for weaker 
black and white images in many cases.  
 
Artist David Hockney said, The camera only sees what 
you see. But if you don't see anything you can't photograph 
it. Seeing, not just looking, is the essence of photog-
raphy. So if you want to work in black-and-white it 
helps to see your subject in tones of white to black 
with middle grays between. In the days of film photog-
raphy you had to train your mind not to see colors be-
cause there was no way technically to filter out color 
in the viewfinder. There were many attempts to do 
that, the use of blue and red filters for example,  but 
most photographers found these devices unsatisfacto-
ry, and so they developed the ability to filter out the 
color with their mind. You saw color but mentally 
translated the hues into shades of gray.  Then along 
came digital 
photography 
and suddenly 
there was the 
technical abil-
ity to actually 
see a world 
without color 
through an 
electronic 
viewfinder or 
on an LCD 
screen , a radi-
cal innovation 
overlooked by 
many working 
in black-and-
white. 
 

 One drawback is that the optical viewfinders of 
DSLRs are like film cameras; they only show the world 
in color although many now are coming with LCD 
screens and live view. The irony is that many smaller 
and cheaper systems - mirror less cameras for example 
- allow a photographer to frame the world while seeing 
in shades of gray.  My own practice, using professional-
level cameras that only have an LCD screen for a 
viewfinder, (a Sony RX-100 or a Panasonic GH2), is 
to record every image simultaneously as both a RAW 
file and a JPEG file . The JPEG is monochromatic and 
that is what I see in the viewfinder. But the RAW file 
( unseen by me in the viewfinder) remains in color. I 
have to admit that sometimes I prefer the color ver-
sion to my monochromatic image; the idea is to keep 
an open mind, not to follow a rigid rule. 
 
Below are some examples. The first image is the raw 
file version in color, along with the monochrome im-
age representing what I saw in the viewfinder. The 
color image to my eye looks like an ad for that excel-
lent watering hole, the Limerick Inn in Wheaton. But 
the black and white version has a mood that goes be-
yond the description of a bar; it becomes a picture of a 
lonely fellow watching basketball game, and most peo-
ple who have seen the pictures have agreed with my 
choice. On the other hand, with the second image I 
preferred the color version as seen in the RAW file. 
The black-and white was interesting, but adding a 
touch of red and orange in an otherwise monochro-

matic image 
made it, in  my 
estimation, a 
more evocative 
picture. So my 
suggestion - sug-
gestion, not a 
rule! - is that if 
you’re going to 
work in terms of 
tones instead of 
hues, your pic-
tures are likely 
to be more 
convincing as a 
black and 
white image if 
you first see the 
world that way. 
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Michael Koren, Lot’s Wife by the Pool 

Mysterious Exhibit 
Roy Sewall 

In the bio of this month’s judge, Roy 
Sewall, you may have noticed that one 
of his photographic subjects is 
“mysterious scenes of people in the 
woods.” Come see what the mystery is 
all about! Roy is hosting an open house 
on Sunday, February 24, from 3:00 to 
6:00 pm. It will feature the entire 2012 
collection of “People of the Woods.” 
The location is Sewall Photography 
Studio, 5619 Oak Place, Bethesda, MD 
20817. For more information, you can 
call Roy at 301.530.6720, or you can 
send him a note at roy@sewallinc.com.  

The Fields Project 
Bill Rau 

 
Bill Rau has participated in The Fields Project, which brings Art and Ag-
riculture together, in years past. The event runs from June 15-23 this 
year.    
 
Recharge your artistic batteries with this unique experience! 
-Paint and photograph the beautiful Rock River panorama 
-Enjoy social and enrichment activities of the week 
-Experience the fellowship of living with farm families 
 
The week culminates with an Art Fair and sale on June 23rd at Mix Park.  
Offerings from Visiting Artists, Regional Artists and the Eagles Nest Art 
Group will populate the Fair.  Entries into the 10th annual and Final, 
Community Art Legacy sculpture competition will also be on display. 
 
 See www.fieldsproject.com for details.  
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Koller, Empty Corner Shadows 

Mark Ratner, Antique Car 

Mike Lux, Sicily 

Pretty Good Deals 

Peachpit Press is offering a 35% discount off the list price 
of one, or 40% off the list price of two or more Photog-
raphy titles. Use the coupon code PERF when you check 
out. The offer ends March 31, 2013 and does not apply to 
eBooks. You can also sign up to receive the weekly $9.99 
eBook special offer on books (sometimes on photography) 
that retail for over $40. 

The Washington School of Photography is offering four 
photography courses which normally cost $245 for only 
$99. Save 59%! Choose Intro to Photography, Intermedi-
ate Photography, Photographic Composition or Using 
Flash.  More information can be found at:                    
http://washingtonschoolofphotography.com/SaveLocal  

A free digital issue of Photo Technique magazine is still 
available at http://phototechmag.com/free-issue-download/ 

In case you missed the January 17 Education Night on abstracts, speaker 
John Naman has generously posted the presentation on his Web site. Now 
all SSCC members can see interesting examples of abstracts and get a per-
spective on what is – and isn’t – an abstract photograph. Here’s the ad-
dress: 
http://photos.dewpix.com/JohnNaman/Presentation/Abstract-Photography  
And don’ forget:  If you want John to give a detailed professional critique 
on one of your abstracts, email him a JPG (competition size) no later than 
February 3: sscc@dewpix.com 

Education Night Redux 

“…the poetry of photography, free verse  
written in color and tone producing feelings of 
mystery regarding what the image is and what 
it is trying to say. Abstracts are an art form 
and like other works of art are felt as well as 
seen.”  ~Joe Miller 

Food for Thought 
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Mark Ratner Pyramid Hotel 

Kay Carkhuff, Gone with the Wind 

Karen Carkhuff, Last Samurai 

Symbol Mac Windows 

© Option-G Alt-0169 

® Option-R Alt-0174 

™ Option-2 Alt-0153 

• Option-8 Alt-0149 

–(en dash) Option-dash Alt-0150 

—(em dash) Option-Shift-dash Alt-0151 

… Option-; Alt-0133 

‰ Option-Shift-R Alt-0137 

¿ Option-Shift-/ Alt-0191 

¡ Option-1 Alt-0161 

† Option-T Alt-0134 

‡ Option-Shift-7 Alt-0135 

€ (Euro) Option-Shift-2 Alt-0128 

£ (British Pound) Option-3 Alt-0163 

¥ (Japanese Yen) Option-Y Alt-0165 

° (degree) Option-Shift-8 Alt-0176 

Ü Option-U, then U Alt-0252 

Ö Option-U, then O Alt-0246 

Ä Option-U, then A Alt-0228 

É Option-E, then E Alt-0225 

Á Option-E, then A Alt-0225 

Ô Option-I, then O Alt-0244 

Â Option-I, then A Alt-0226 

Clip And Save 
Bob Catlett 

Creating Symbols in Documents and in Images 
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Seeds of Rebirth: The Thousand-year Lotuses of Kenil-
worth -Photos by Gene Luttenberg. Zed's Café, 8225 
Georgia Avenue, Silver Spring. Artist’s reception Sun-
day, February 3, 2-4pm.  
 
Journeys-Photography by Jim Auerbach, Carl D. 
Brandt, Alam Burhanan, Greg Holden, Stan Klem, 
Dave Mullen, MyPhuong Nguyen, Elise Shurie, Ha 
Tran, and Michael Tran. February 2 - April 8. Artists’ 
Reception March 23, 1-3pm. Tate Gallery, Christ Con-
gregational Church, 9525 Colesville Rd., Silver Spring,  
 
Zwilethu Mthethwa – Eight color portrait photographs 
by the South African artist.  Through February 10.  
Baltimore Museum of Art, 10 Art Museum Dr., Balti-
more.  www.artbma.org 
 
Endangered Species: Watermen of the Chesapeake – 
Black & white images by Glen McClure.  Indefinitely. 
Calvert Marine Museum. 
www.calvertmarinemuseum.com 
 
Nature’s Best Photography Awards Through April 30.   
National Museum of Natural History. www.mnh.si.edu 
   
The Wild Horses of Sable Island – Images by Roberto 
Dutesco. Embassy of Canada.  501 Pennsylvania Ave., 
NW, Washington, DC.  202-682-7732 
 
Ansel Adams at the Wilderness Society – More than 80 
works on permanent display.  1615 M St., NW, DC. 
http://wilderness.org/anseladams. 
 
The Solemnity of Shadows: Juan Laurent’s Vision of 
Spain  23 albumen photographs depicting 19th century 
Spanish art and architecture.  National Gallery of Art, 
East Building.  www.nga.gov 

Photographs of the Civil Rights Movement and March 
on Washington: 45th Anniversary  Open indefinitely.   
Historical Society of Washington.  www.historydc.org 
 
Snapshot: Painters and Photography, Bonnard to Vuil-
lard  Shows how 19th century painters adopted photog-
raphy as both a painting aid and an expressive medium 
in itself.  The Phillips Collection. 
www.phillipscollection.org 
 
Matthew Brady’s Photographs of Union Generals  
Studio portraits by the famous Civil War photogra-
pher.  National Portrait Gallery. Through May 31.  
www.npg.si.edu 
 
Taryn Simon: A Living Man Declared Dead and Oth-
er Chapters I-XVIII – Photography and text reveal 
social changes driven by science, culture, and 
chance.  Through February 24.  Corcoran Gallery of 
Art. www.corcoran.orgrcoran.org 
  
Detroit Disassembled: Photographs by Andrew Moore 
30 monumentally scaled photographs reveal Detroit’s 
ruins. Through February 18.  National Building Muse-
um.   www.nbm.org 
 
Detroit is no Dry Bones: Photographs by Camilo Jose 
Vergara  The sociologist documented the city’s decline 
for more than 25 years.  Through February 18.  Nation-
al Building Museum.  www.nbm.org 
 
Utopia – Enoc Perez’s architectural portraits.  Through 
February 10.  Corcoran Gallery of  Art.   
www.corcoran.org 

Exhibits and Events 
Ted Ringger 

© 2012 Aaron Johnson, Used with permission. 
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Classes and Workshops 
David Blass 

*Nikhil Bahl Workshops 
  Private Instruction and Custom Workshops available 
  Creative Compositions & Processing Techniques, April 6-7 
  Macro Boot Camp, April 13-14 
  Flowers & Close-ups, April 20, 6:30am to 9:30am 
  Great Smoky Mountains, April 23-28 
  Chincoteague Island One-day Workshop, June 8,  
  West Virginia, Oct. 5-9 
  Chincoteague Island One-day Workshop, Oct. 19  
 www.nikhilbahl.com 
 
*Washington School of Photography 
  Wildlife Photography, Fri. Feb. 1, 8, 15, 10am-1pm 
  Focus on Composition, Sun. Feb. 3, 2-5pm 
  Fashion Photography, Feb. 6, 7, 14, 1:30-4:30pm 
  Metering and Exposure, Tue. Feb. 12, 1:30-4:30pm 
And many more at www.washingtonschoolofphotography.com 
 
*Horizon Workshops 
  Adobe Lightroom, Sat. March 16, 10am-5pm  
  Flash Magic, Indoors & Out, March 23-24. 
And many more at www.horizonworkshops.com 
 
Joseph Van Ost Photo Safaris 
  Venice at Carnival, Feb. 6-13 
  Aurora Borealis, Fairbanks, Alaska, Mar. 7-14 
  Tanzania—Serengeti National Park, Mar. 16-30 
  Midway Atoll, Hawaii, Mar. 18-26 or Apr. 1-9 
  Holland at Tulip Time, Apr. 13-24 
  Great Smoky Mountains, Apr. 20-26 
  Turkey—Continental Crossroads, May 11-26 
  Kenya Wildlife, Aug. 23-Sep. 7 
  China’s Unknown Landscapes, Sep. 10-24 
  World’s Best Raptor Shoot (Colorado), Oct. 12-17 
  Bald Eagles of Chilkat River, Alaska, Nov. 17-23 
  Faces of Burma, Nov. 29-Dec. 16 
www.photosafaris.com 
 
Smithsonian Associates 
  Digital Camera Basics, Sun. Feb. 10, 10am-5:30pm 
and others at  http://search.atomz.com/search/?sp-a=00030f3e-
sp00000000&sp-q=photography 
 
National Geographic 
  Creativity with Light, Apr. 21 
www.nationalgeographic.com/ngtseminars/series/spring.html 
  Scottsdale Photo Weekend Workshop, Apr. 19-22 
www.nationalgeographic.com/ngtseminars/series/scottsdale.html 
 

Cory Hilz Photography 
  Lonaconing (MD) Silk Mill, Mar. 16-17 
  Charleston, SC, Mar. 26-29 
  Maryland’s Eastern Shore, May 17-19 
  Spring in West Virginia, May 31-June 2 
  Cape May & Ocean City, NJ, Sep. 6-8 
  China, Sep. 12-27 
And more at  http://coreyhilz.com/learn.html 
 
Capital Photography Center 
  National Cathedral Photo Safari, Sat. Feb. 2, 1:30-4:30pm 
  U.S. Botanic Garden Photo Safari, Sun. Feb. 3, 2:30-5pm 
  Lightroom & Raw, Sat. Feb. 9, 9:30am-4:30pm 
  Macro: Baltimore Conservatory, Sat. Feb. 16, 10am-2pm 
  Intro to Photoshop/Elements, Sat. Feb. 23, 9:30am-4:30pm 
Many other workshops at various locations. 
  http://capitalphotographycenter.wildapricot.org/ 
 
Glen Echo Park 
  Mat Cutting Made Simple , Sat. Feb. 2, 9:30am-12:30pm 
  Basics: f/Stop & Shutter, Mon. Feb.4-Apr.15, 7-9:30pm 
  Get Out of Auto Mode, Sun. Feb. 10-24, 11am-2pm 
  Fine Art Digital B&W Printing, Sat. Feb. 23, 10am-4pm 
  And others at 
  http://register.glenechopark.org/class/classclassIndex.aspx?
ctlgID=41&ctgyID=32&typeID=2 
 
Art Wolfe 
  Myanmar, Feb. 4-14 
  Bhutan, Mar. 25-Apr. 6 
  Vietnam, May 16-26 
  Bali, Indonesia, July 12-22 
  Namibia, Africa, Sep. 4-14 
  Morocco, Nov. 2-17 
  The Wilds of Hawaii, Dec. 2-7 
And more at  www.artwolfeworkshops.com 
 
Ghost Town Safari 
  China, An Adventure in Culture, May/June 
  http://ghosttownsafari.com/category/workshops-and-safaris/ 
 
Suzi Eszterhas 
  Wildlife of Brazil, Sep. 1-15, 2013 
  Pantanal Wildlife, Brazil, Sep. 15-29, 2013 
  Wildlife of India, Nov. 2013 (dates TBA) 
  www.suzieszterhas.com/toursWorkshops 
 
* Past SSCC Speaker and/or Judge 
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Larry Burton, From Alcatraz 

Larry Burton, Sunrise from Grand Canyon South Rim 

Book Review 
LIDLIPS, by Syl Arena 

Dave Mullen 
 

LIDLIPS: Lessons I Didn’t Learn in Photo 
School by photographer and prolific blogger 
Syl Arena is a series of 100 very brief essays 
on photography, including thoughts on art, 
business, science, and lifestyle. The essays 
are not meant to be read in order, nor the 
book in one sitting.  Some titles include: If 
you can’t be remarkable, be memorable, 
You are not defined by your photo gear or 
your computer’s operating system, Your 
photographs have value-Don’t give them 
away. At the end of  each essay is a ques-
tion meant to provoke further reflection. 
The book costs around $15 and is available 
on Amazon and other book stores.  
Recommended.   http://amzn.to/12kRSgm 
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Mirrorless In Manhattan 
Experiments with the Olympus Micro Four-Thirds Cameras 

Coriolana Simon 

Taking advantage of discount coupons and 
travel points, Doug and I took a 3-day holi-
day in New York mid-December. This was 
not to be a photography adventure. We 
built our brief itinerary around two features:  
a backstage tour of the Metropolitan Opera, 
where no photography is permitted, and a 
long visit to the new Islamic galleries at the 
Metropolitan Museum of Art. As a New 
Yorker myself, I wasn’t interested in shoot-
ing the landmarks and monuments I grew 
up with. And street photography in the 
madness of midtown Manhattan didn’t 
seem like a good idea. 
But we each wanted to take a camera, just 
in case. The trouble was, which camera? Our full frame 
Canons? No! Too heavy, too cumbersome for the occa-
sional shot. Our small sensor Canons? No; almost the 
same problem. Our little point & shoots? No, these 
really wouldn’t be adequate. So we decided to experi-
ment with our Olympus mirrorless, interchangeable 
lens, micro four-thirds cameras. Olympus has been ter-
rific at making smaller-than-average, elegant, high per-
formance cameras for over 50 years, going back to the 
Pen FT half-frames in the 1960s – and one of these was 
my very first real camera. 

   I already had 
Olympus’s first 
micro four-thirds 
“flagship”: the E-
P2. It’s gorgeous 
and has served 
me well, but for 
our holiday I 
wanted the newer 
model with the 

updated sensor and focusing system: the OM-D E-M5. 
Doug had the tiny Olympus E-PM 1, which he’d never 
really used and wanted to try out. 
   So what are these cameras like? And where do they 
fit in with the families of camera types on the market? 
Primarily, they are very, very small – hardly bigger than 
an advanced point & shoot like the Canon G15. This 
makes them a joy to carry around. In fact, my case is 
smaller than my purse, and it holds a body, three 
lenses, two batteries, and the shoe-mounted eternal 
flash. Doug’s Mini is even smaller but still feels well 
balanced with the kit lens or micro four-thirds 50-
150mm (equivalent to about 100mm-300mm with the 

2x crop factor). 
   The compactness makes these cameras 
practical, and unobtrusive, for street 
photography, casual travel, documenting 
exhibits of interest in museums, and 
even shooting concerts. For those who 
are serious about building a micro four-
thirds system, there are more and more 
lenses to choose amongst, including a 
macro. In addition, the Panasonic micro 
four-thirds lenses work on the Olympus 
without even an adapter. 
Well, if they’re so great, why isn’t every-
one switching to micro four-thirds? They 
do have some disadvantages. Fundamen-

tally, they are not DSLRs and shouldn’t be considered 
as smaller but equal substitutes. Their size, for one 
thing, can even be a disadvantage. If you have large 
hands, they can feel awkwardly diminutive. Their 
price, however, is anything but small. The body of the 
OM-D E-M5 and its competitors sells for around $1000 
(street). The mediocre 14-42 II mm lens (28mm-85mm 
equivalent) runs only about $300, but you get what you 
pay for. The newer12mm-50mm kit lens (24mm-
100mm equivalent) sells separately for about $400 with 
rebate. It’s weather-sealed, but its quality doesn’t come 
anywhere near the phenomenal Olympus 12mm-60mm 
DSLR lens. The micro four-thirds primes, of course, are 
finer and faster than the zooms, but carrying an arsenal 
of lenses defeats the purpose of the whole system, in my 
view.  
   What about picture quality? Overall image quality 
seems to cause 
the greatest dif-
ferentiation be-
tween these at-
tractive mirrorless 
micro four-thirds 
cameras and 
DSLRs. Shooting 
at ISO 1600 was a 
bit of a stretch for 
the E-M5, and 
many of my imag-
es required noise 
reduction in 
Lightroom. Be-
cause of lighting 
conditions, such 
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The Mid-Atlantic Chapter of the Photographic Socie-
ty of America (PSA) is for individual members of the 
society in the geographic area within a 150 mile radius 
of Washington, DC; including Virginia, Maryland, the 
District of Columbia, Delaware, New Jersey, West Vir-
ginia, and Pennsylvania. The Mid-Atlantic Chapter of 
PSA received its charter in 1997 at the PSA Annual 
Conference held in St. Charles, Illinois. 
  
All members of the Mid-Atlantic Chapter must be 
members of PSA.  PSA members residing in the geo-
graphic area served can become Chapter members. 
Interested PSA members from out of the area are  
invited to participate in Chapter activities with the 

exception of the Annual Competition. Area photogra-
phers are invited to join PSA and contact the Chapter 
Membership Vice Chair to join the Chapter. The 
Chapter tries to have two program meetings, one An-
nual Competition, one cookout/picnic, and one or two 
field trips each year. 
 
As in SSCC, all Chapter notifications are handled via 
email.  
  
Interested SSCC members can see some great photos 
in the PSA MAC gallery: www.psa-photo.org/about-psa/
psa-chapters/chapters-list/mid-atlantic-chapter/ 

PSA News 
MyPhuong Nguyen 

as interiors of churches, 
night scenes, and museum 
displays, I frequently shot on 
i-auto, just to see what the 
camera would produce and 
how it would optimize the 
conditions. The results were 
better than I anticipated: 
the image stabilization 
worked well (no tripod on 
the trip), pictures were ac-
ceptably crisp, and noise 
levels were manageable. 
Doug’s experience was far 
less satisfying. He found that the E-PM1 developed 
unacceptable noise even at ISO 400, and he’s now or-
dered the E-M5 like mine. 
   And what about ease of use? These Olympus micro 
four-thirds cameras are not easy to use – that is, for 

photographers accustomed to Canon. It’s like learning 
another language and keeping a grammar book or dic-
tionary close at hand. Olympus tends to be menu-
heavy and offers a bewildering number of different 
ways to perform the same action and to customize the 
camera. It takes time to get used to it. On the other 
hand, the E-M5’s touch-screen option does speed up 
picture taking. The E-PM1, though, and its newer rela-
tives like the E-PM2 (body about $450 with rebate) 
and E-PL5 (body about $550 with rebate; with 14-
42mm lens about $600 with rebate) have a frustrating 
lack of dials and wheels and require menu-diving for 
the simplest tasks. Once you get the hang of it, though, 
these very small cameras are fun to use. 
   Bottom line: Based on three days of what turned out 
to be non-stop shooting – and not based on any tech-
nical tests or even reading of reviews – I can recom-
mend the Olympus OM-D E-M5 as a comfortable walk
-around camera that feels great in the hand and pro-
duces surprisingly good images.  
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   In July of 2012, I got the 
chance to visit the Pike 
Place Public Market in 
Seattle, Washington. I 
loved this place so much 
that I would definitely go 
back if I ever got another 
chance. On my trip, I 
originally planned to visit this place twice but it was 
love at first sight and I ended up coming by 4 times. 
Upon arrival to the market, I was sucked in by the aro-
ma of fresh bakery and before I knew it, I found myself 
in front of the French bakery. When I first saw the bak-

ery, I was shocked by all kinds 
of breads and lovely pastries on 
display. I stood in line to buy 
some of breakfast and really 
enjoyed how customers like my-
self were able to watch how 
they made their bread and pas-
tries.  
   The Pike Public Place Market 
is about an hour walking tour. 
It has been around for 104 
years. It is the oldest public 
market in the U.S. Lots of in-

teresting shops makes this place quite famous. For in-
stance, the first Starbucks was established here in 1912 
and the legend of flying fish, the Pike Place Fish Boys 
attracted more visitors.  
http://en.wikipedia.org/wiki/Pike_Place_Market  
   The Pike Place 
Public Market Histor-
ic District is located 
six blocks west of 
Hwy 1, near the 
shores of Elliot Bay, 
and is open from 9am 
to 6pm.  
   The market is 
open year round, 
and each table space 
can be rented by the 
day. Many luxury 
stores were built 
right in front of the 
main road and the 
surrounding space, 
but the small tables 
were reserved by 

farmers or craft-
ers. A statistic 
showed that 
there were about 
190 craftspeople, 
100 farmers, and 
240 street per-
formers and mu-
sicians. I named 
this place “The 
Place of Art” be-
cause there were 
musicians and 
performers on 
every corner. 
Many artists, like 
painters and pho-
tographers, live 
there, and sell 
their art through the market. I bought a photo of the 
one of the first Starbucks images taken by a local artist. 
That picture was taken very early in the morning when 
there was no one around except for just one musician 

Pike Place Market, Seattle 
MyPhuong Nguyen 
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Third Annual Joseph Miller Abstract Exhibit 
  Deadline: Feb. 27 
http://nvacc.org/Abstract_Exhibit.html 
 
New York Center for Photographic Art 
  Seasons, Deadline: Feb. 1 
www.nyc4pa.com 
 
Maine Media Workshops & College 
  Spirit of Place, Deadline: Feb. 1 
www.mainemedia.edu/contest 
 
Vermont Photo Workplace 
   Mysterious Visions, Deadline: Feb. 18  
  City Streets, Country Roads, Deadline: May 6 
www.vtphotoworkplace.com 
 
Focal Press Photography Contest 
  Street Photography, Deadline: Feb. 28 
  Color, Deadline: Mar. 31 
http://focalpressphotographycontest.com/ 
 
Linus Galleries (Signal Hill, CA) 
  Fork and Knife, Deadline: Feb. 11 
  Seven Deadly Sins, Deadline: Mar. 4 
  Women, Deadline: Mar. 25  
www.linusgallery.com/call-for-entries.html 
 
 

Black Box Gallery (Portland, OR) 
  Shades of Gray, Deadline: Feb. 5 
  Photo Salon, Deadline: Mar. 12 
http://blackboxgallery.com/CallForEntry.html 
 
A Smith Gallery (Johnson City, TX) 
  Chair, Deadline: Feb. 18 
https://asmithgallery.com/ 
 
The Kiernan Gallery 
    Abstraction, Deadline: Feb. 15 
http://kiernangallery.com/methods-alternative/ 
 
Open to Interpretation (St. Paul, MN) 
  Love & Lust, Deadline: Feb. 12 
http://www.open2interpretation.com/
submit_photo_love_lust.html 
 
1650 Gallery (Los Angeles) 
  You’re an Animal!, Deadline: Feb. 7 
http://1650gallery.com/ 
 
Brooklyn Waterfront Artists Coalition 
  Wide Open 4, Deadline: Feb. 25 
http://wideopenartshow.com/ 
 
SlowArt Productions/ Limner Gallery (Hudson, NY) 
  Art Biologic, Deadline: Feb. 28 
http://www.slowart.com/ 

Calls for Entries 
David Blass 

playing in front of the shop. I wanted to take a Star-
bucks' photo while I was there, so I kept waiting to 
take a picture without anybody in it, but couldn’t. I 
rarely found a shop without any people around unless I 
came there very early in the morning.   
 

The next day we went to a lower level of the 
market which had some small restaurants and gift 
shops. The market was always crowded with more 
vendors, artists and crafters on the weekend. I even 
bought woven hats for my two nieces that were beauti-
fully handmade and designed.  
   In addition to the many aspects that kept making me 
come back, I can’t forget the great performances by 
the street performers which are very popular. I hope 
you will have chance to visit the market. You will cer-
tainly discover many things that would want to make 
you stay. Don't forget bring as many memory cards as 
you can. If you want to see more images from Pike 
Public Market please come to the Journey Exhibition 
at the Tate Gallery. 
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Micro-adjustment analysis on an 18-55mm lens.  
+7 was the recommended adjustment. 

Aperture analysis on an 80-200mm lens. No surprise, f/11 is sharpest. 

  Over the Thanksgiving holiday I spent some time with 
my brother-in-law Jim Kay from Massachusetts, a fine 
shooter despite using Canons instead of Nikons. He told 
me a about a new lens micro-calibration software system 
he had used to calibrate his collection of lenses, which 
he said had made a huge difference in the sharpness of 
his photographs. Being just as nerdy as Jim, I had to give 
it a try. 
   Microadjustments are available on certain camera 
models, and are designed to overcome manufacturing 
variations in lenses and camera bodies that may cause 
even the best lenses and cameras to create slightly soft 
images. The thinking is that by calibrating for the sharp-
est focus for a particular lens/body combination one can 
create sharper photographs. 
   There are a variety of products on the market to help 
with this micro-adjustment. Do a Google search for 
“lens align” and you’ll see what I mean! I decided to go 
with FoCal because it partially automates the process, 
and because Jim had been happy with it. 
   On certain cameras, mostly Canons, the process is 
completely automated, but on my Nikon D7000 I had to 
make manual changes in the micro-adjustments. While 
this wasn’t onerous, it did mean attending to the camera 
and the process rather than reading the newspaper 
while the software did its work. 
   On my Nikon, the settings can be found on 
“Setup>AF Fine Tune.” The camera allows me save 
settings for up to 12 “fine-tuned” lenses with micro-
adjustments ranging from +20 to –20. The software 
must be installed on your computer, and your camera 

must be tethered to your computer with a USB cable. 
Once hooked up, the software takes a series of expo-
sures of a target image that you must print out. After 
each exposure you are prompted to change the micro-
adjustment, although on some models the software will 
do this for you, completely automating the process. Af-
ter running through all the possible exposures, the soft-
ware analyzes for the sharpest image and you then store 
that micro-adjustment for that particular lens.  
   The software will also run through an aperture analy-
sis, shooting the target at all available apertures to de-
termine the sharpest. While this is something you can 
do for yourself, it was fairly interesting to see a neutral 
analysis. 
   What was my experience? Not as good as Jim’s, I’m 
afraid. There were variances, but they seemed pretty 
minor. On my big lens, the 80-200mm f/2.8, the soft-
ware had trouble coming up with an analysis even 
though the camera was on a tripod. In short, I don’t 
think I would purchase this software again. It should 
also be noted that the software is registered to a particu-
lar camera body and thus can only be used with that 
body. If you get another body you can deregister the first 
and reregister, but the software cannot be shared with 
another shooter.   
   I’ve included a couple of screenshots of the PDF re-
ports that FoCal produces so you can evaluate for your-
self if this is something you want to try. To see if it 
works with your camera you can check it out at   
www.reikan.co.uk/focalweb/. Be sure to look at other lens 
calibration tools as well before you buy. 

Software/Hardware Review 
FoCal 

Dave Mullen 
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© Tim Grey, reprinted with permission 

The Question: I downloaded some free photo borders/
edges and have figured out how to frame photos with some 
of them by changing color, sizes, deleting the center, 
etc.  But I want to use them as a layer mask. Is there a 
way to do that without making the image a brush? 
 
Tim's Answer: You most certainly can use the photo 
borders you've downloaded as the basis of layer masks. 
In concept this is very easy, though there may be a few 
fine-tuning pieces depending on a few factors. Here's 
the approach I would generally use: 

The first thing I would do is bring the photo border 
you've downloaded into the image where you want to 
use that shape as a mask. It is worth mentioning at 
this point for readers who aren't familiar that these 
photo borders will generally be black and white images 
(mostly quite literally black and white without shades 
of gray, though some shades of gray are possible. In 
some cases there may be transparent pixels rather than 
either black or white pixels, but that is less common. 

There are, of course, a number of ways you could place 
the photo border into the image, but the way I recom-
mend in terms of the overall process here is to use the 
Place command, found on the menu at File > Place. 
Start by opening the image you want to add the photo 
border to and then clicking on the thumbnail for the 
top-most layer on the Layers panel to make sure it is 
active. Then choose File > Place from the menu, and 
navigate to and select the image you want to add as a 
photo border (or otherwise use as a layer mask).  

When you click  the Place button, the image will be 
placed in the document, with controls much like you 
will find for the Free Transform command. Drag each 
of the four corners to the corner of the photo, so that 
the two images will match up in terms of pixel dimen-
sions. Then press Enter/Return on the keyboard to 
apply the change. 

By the way, if you're using an older version of Pho-
toshop that doesn't include the Place command, you 
can also simply arrange the windows in Photoshop 
after opening both the image and the photo border. 
Then click on the top-most layer for the image on the 
Layers panel and then use the Move tool to drag the 
photo border into the photo. 

At this point you have a photo border on top of your 
photo, and that photo border is resized to match the 
image. Next you want to create a selection based on 
this border. If the border consists of transparent pixels 
in the non-border area, you can simply hold the Ctrl 
key on Windows or Command key on Macintosh and 
click on the thumbnail for this photo border layer on 
the Layers panel. If the photo border consists of black 
and white (and possibly gray) pixels throughout, you 
can instead go to the Channels panel (choose Window 
> Channels from the menu if it isn't currently visible) 
and then click the Load Channel as Selection button 
(the dashed circle icon) at the bottom of the Channels 
panel. This will load a selection where white pixels are 
selected, black pixels are deselected, and shades of 
gray are partially selected. 

If at this point the selection does not represent the 
area you want to be visible based on the layer mask, 
you can choose Select>Inverse from the menu to in-
vert the selection. For example, if you want to hide 
the outer portion of the image using a layer mask, you 
would need the interior portion of the image selected. 
A photo border image that is white around the edges 
and black in the center would yield the opposite selec-
tion. 

At this point you have a selection, which can be used 
as the basis of a layer mask. You can, for example, 
simply add a new image layer by clicking on the Create 
a New Layer button (the blank sheet of paper icon) at 
the bottom of the Layers panel and then click the Add 
Layer Mask button (the circle inside of a square icon) 
at the bottom of the Layers panel to add a layer mask 
to that layer. The image layer could then be filled with 
a color, for example, but those pixels will only be visi-
ble based on the layer mask. And of course, you could 
use the selection as the basis of a layer mask for an 
existing layer by simply choosing that layer on the Lay-
ers panel and then clicking on the Add Layer Mask 
button (the circle inside of a square icon) at the bot-
tom of the Layers panel to add a layer mask to that 
layer. 

 

Ask Tim Grey 
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Link Notes: Adobe Acrobat does not always translate 
the Hyperlinks in the original publication into  
Hyperlinks in the Adobe PDF file.  Specifically, mul-
ti-line websites or websites that do not  include 
“www” seem to be particularly affected.  If a link 
does not work, you may need to Copy and Paste the 
text into your web browser.  
   To get the latest version of Adobe Reader, use this 
Hyperlink:  http://get.adobe.com/reader/otherversions/ 

Stay In Touch with SSCC 
www.ssccphotography.org 

 
www.twitter.com/ssccphoto 

 
http://groups.google.com/group/sscameraclub 

 
www.flickr.com/groups/sscc_picture_a_day 

 
www.facebook.com/pages/Silver-Spring-Camera-

Club/147660948590014?ref=sgm 
 

www.magcloud.com/user/wehs 

News You Can Use 

Times are for Washington DC.  www.timeanddate.com 

Full Moons 

Sunrise and Sunset 

Date Sunrise Sunset 

February 1 7:14 am 5:30 pm 

February 15 6:59 am 5:46 pm 

February 28 6:42 am 6:00 pm 

Date Moonrise Moonset 

February 25 6:07 pm 6:16 am 

March 27 8:07 pm 6:50 am 

Mark Ratner, Butterfly on Ceiling 
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Dave Powell, Azaleas 

The Back Page 
Random stuff from yr. hmble. Ed. 

Washington, D.C., circa 1922. "Minker Motor Co., 14th Street 
N.W." National Photo Company Collection glass negative.  

My new best friend in computing is Dropbox, as I try to 
manage images between my PC, iPad, and Android 
phone.  How does this app help? It provides “cloud” stor-
age for my photos, indeed, for any files. I’ve been able to 
pass on music to my daughter in Africa by sharing a fold-
er with her. I’m able to put a photo shot on my Android 
phone in my Dropbox. I’m able to move portfolio images 
from my computer to my iPad using Dropbox. All in all 
its become an invaluable tool in managing my images. 
 
Dropbox is free for 2GB of storage. After that you can 
either pay for additional storage or get more free storage 
by inviting friends. Thus my invitation to you: use this 
link http://db.tt/ItPvmUPe to join Dropbox and I’ll share 
a special bonus with you in an SSCC Dropbox folder! 
Once you’ve begun using Dropbox I think you’ll be 
hooked. 

Application of the Month 
Dropbox 

http://db.tt/ItPvmUPe 
Interested in old images? I’ve previously highlighted 
the Library of Congress site where you can download 
images, but you can now add Shorpy to the list. Un-
like the Library of Congress, you can’t download high 
resolution  images from Shorpy, but if one strikes your 
fancy you can order a print. There are thousands of 
images on this deep site, so if you like historical pho-
tography start digging in! 

Website of the Month 
Shorpy.com 
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THE CABLE RELEASE  SUBMISSION DEADLINE  
is the 24th of each month. 

SSCC Calendar 
Upcoming Events 

 
February 2013 
         7   Speaker Meeting; Projected Deadline 
       14   Competition Night: Abstract 
 16 Field Trip: Baltimore Conservatory 
 21 Education Night 
 24 Cable Release Deadline 
 28 Board Meeting 
 
March 2013 
         7   Speaker Meeting; Projected Deadline 
       14   Competition Night: Open 
 21 Education Night 
 24 Cable Release Deadline 

Ron Freudenheim, Ghost Flowers 


